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Welcome and Setup
What’s inside…
Welcome to Building Your World, an exciting introduction to design 
and visualization with AutoCAD solid modeling! If you have never had 
time to try solid modeling, or if you have and hope to find some good 
tips and tricks, you’ve come to the right place.

Objectives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Drawing File Location . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3



2 Chapter 1 Welcome and Setup
Objectives

Building Your World will provide you with important concepts and techniques in solid 
modeling. The information can be used for conceptual design and visualization in many 
disciplines, such as architecture, mechanical design, and civil engineering. The objectives of 
this guide are

■ To provide a strong foundation in the basics of solid modeling in AutoCAD
■ To present practical information about efficient techniques and common pitfalls of solid 

modeling
■ To provide a learning environment for additional study and experimentation

Prerequisites

This guide is intended for experienced AutoCAD users. To complete the exercises in this 
guide, you should know how to do the following:

■ Zoom and pan
■ Specify 2D Cartesian coordinates
■ Use object snaps
■ Create, select, and modify 2D objects
■ Work with layers
■ Create and insert blocks
■ Change system variables at the Command prompt

If you are new to AutoCAD, it is strongly recommended that you complete the Getting Started 
guide first. The Getting Started guide provides basic information and tutorials about using the 
program. You can obtain the Getting Started guide in one of the following ways:

■ If available, use the documentation coupon included in the product package.
■ Purchase a copy from www.autodesk.com.
■ Open the free PDF version of the Getting Started guide that is included on your installation 

CD. In the Installation Wizard window, click the Documentation link at the bottom-left 
of the window to access the PDF.

Once you are familiar with AutoCAD, you will be ready for Building Your World.
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Setup

Before you begin working through this guide, start AutoCAD, and then from the Workspaces 
toolbar, specify the 3D Modeling workspace. The Workspaces toolbar is located at the top-left 
of the AutoCAD application window by default.

If the Workspaces toolbar is not displayed, right-click any toolbar. Then, on the shortcut 
menu, click Workspaces. Then select 3D Modeling in the drop-down list.

The 3D Modeling workspace consolidates several toolbars and controls into the dashboard for 
convenient access to commonly used 3D modeling commands and settings.

Drawing File Location

This guide includes exercises for you to try the concepts and features that are presented. The 
drawing files that you need for these exercises are in the \Help\buildyourworld folder, which 
you will find in the AutoCAD installation folder.

NOTE The drawing files used in the exercises include models that use either metric or imperial 
units. While this affects the scale and proportion of the models, it has no significant effect on 
learning solid modeling.

You are now ready to begin exploring the power of 3D solid modeling with AutoCAD.

View and navigate within a 3D model

Create and modify 3D solids

Control the lighting within a 3D model

Control the visual display style of a 3D model

Control the materials assigned to 3D solids

Control the rendering options for a 3D model
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Introduction to Solid Models
What’s inside…
It’s easy to create a 3D solid model from a 2D design. When you work 
with a 3D model, the effects of a design change are much easier to 
visualize. With a 3D solid model, you can analyze and present your 
design more effectively.

Use Your 2D Drawings to Create Solid Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Visualize Your Designs While You Work  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Explore Design Alternatives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Apply Analysis Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Present Your Designs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11



6 Chapter 2 Introduction to Solid Models
Use Your 2D Drawings to Create Solid Models

Your drawings are a treasure trove of resources that can be easily reused to create solid models. 
For example, this 2D library design was extruded into a 3D solid model.

Solid models are an excellent tool for visualizing, analyzing, and presenting your designs. 
Visualizing a chair design is much easier using a solid model than viewing standard 
orthographic projections.

2D drawing

Isometric view

Extruded in 3D
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Most of the commands and settings that you already use for 2D drawings are also used to 
create and modify solid models. For example, these chairs were copied and rotated.

The FILLET command was used to round the inside and outside edges of this plastic box. 
Midpoint object snaps were used to create a reference line across the opening.

Common operations and tools used in solid modeling include

■ Move
■ Copy
■ Rotate
■ Fillet
■ Object snaps
■ Polar snap



8 Chapter 2 Introduction to Solid Models
Visualize Your Designs While You Work

Changing 3D perspectives and views can aid design decisions. Also, you can choose from 
several visual styles to increase comprehension and reduce the clutter while you create and 
modify solid models.

This kitchen was remodeled to include a new pantry and a peninsula (shown in brown). 
Several perspectives were used to confirm design decisions.
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Explore Design Alternatives

You can easily modify a solid model. Speeding up and increasing the number of design 
iterations improves the quality of the design and reduces the probability of expensive design 
changes late in the process.

To enhance performance in archery, this old-style bow sight design was lengthened .
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Apply Analysis Tools

Solid models can be used for several kinds of 
analysis. For example, the volume of 
polyethylene used in this bottle was easily 
obtained by using the MASSPROP command. As 
shown in the illustration, you can also create 
cross sections of a solid model easily.

Other tools are available for lighting and 
shadows. For example, the proposed library for 
this university campus may cast a significant 
shadow at certain times of the day during the 
year. 
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Present Your Designs

Solid models can be displayed for effective communication of design intent. Several visual 
styles and perspectives are at your command. Also walkthroughs and flyovers can be 
performed and incorporated into animated presentations.

The following images of a Japanese-style room design display the predefined visual styles in 
AutoCAD. Visual styles can also be customized. At the lower-left is a rendered image of the 
room design.

Once you create a 3D solid model, it becomes a significant resource for many applications. 
The following chapters will show you how easy it is to create and modify 3D solids.

Realistic visual style Conceptual visual style

Rendered image Hidden visual style
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View Models in 3D
What’s inside…
When you work with solid models in 3D, it is essential to become 
skilled at changing viewpoints and visual styles for clarity and 
convenience.

Change Views Dynamically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Control the Display Properties of Solid Models  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Specify Precise Views  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Use the Dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24



14 Chapter 3 View Models in 3D
Change Views Dynamically

In the following illustrations of a kitchen remodeling plan, a new peninsula, pantry, and trim 
are shown in brown lines. However, 3D views provide important additional visual 
information.

The 3DORBIT command is the most convenient way to change a 3D view dynamically.

TIP Work in 3D views to select objects easily and to avoid mistakes due to visually overlapping 
edges.

New pantry

New peninsula

Front view of kitchenPlan view of kitchen

New trim
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Try it: 

1 In the \Help\buildyourworld folder, open the drawing 31 Kitchen.dwg. 

2 Click View menu > Orbit > Constrained Orbit. 

3 To specify a 3D isometric view, click and drag the cursor along the path shown by the 
arrow in the illustration above.

4 Click and drag the cursor several more times for additional viewing angles.

5 Press ESC to exit the command.

As you can see, 3D isometric views result in more complete, but visually complex, views.

TIP It is extremely important to use layers to organize 3D models! Turn unneeded layers off to 
reduce the number of objects that are displayed at the same time.

Result
Click and drag 
along this path
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Currently, the kitchen is displayed with the 3D Wireframe visual style. You can choose from 
several visual styles, and you can change from an isometric view to a perspective view. 

Try it:

1 Start the 3DORBIT command and right-click to display the shortcut menu.

2 Click Visual Styles > Realistic.

3 Change the view orientation for a better view of the remodeling plan.

4 On the same shortcut menu, click Perspective and try several other viewing angles. 

5 Change your location with respect to the kitchen by clicking Other Navigation Modes > 
Adjust Distance, and dragging the cursor up to move into the middle of the kitchen.

6 Right-click and then click Other Navigation Modes > Constrained Orbit to view the 
kitchen from the middle of the kitchen. Press ESC to exit the command.

7 Click the Layout button near the middle of the status bar at the bottom of the application 
window to display a layout with several views of the kitchen.

8 Close the drawing.

TIP If you need to see only a few objects in a model, select the objects before starting 3D Orbit, 
and only the selected objects will be visible during 3D Orbit operations.

The next exercise uses a solid model of a connecting rod from an antique sports car.

Realistic visual style Perspective turned on
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Try it:

1 In the \Help\buildyourworld folder, open the drawing 32 Conrod.dwg.

2 Click View menu > Orbit > Constrained Orbit.

3 Click and drag to specify 3D views dynamically.

4 While still in 3D Orbit, right-click to display the shortcut menu. On the shortcut menu, 
click Other Navigation Modes > Continuous Orbit. Click and drag to give the connecting 
rod a spin!

5 Try changing the visual style and projection from the 3D Orbit shortcut menu.

6 Press ESC to exit the command.

7 Change the color of the 10 SOLID layer. Then repeat the previous steps.

However, you can still access 
legacy shading options on the 
command line.

Try it:

1 On the command line, 
enter -shademode and 
specify Gouraud.

2 Repeat to experiment with 
the various options. A 
popular option for 
creating and editing solids 
with many sharp edges is 
Gouraud with Edges.

3 Close the drawing.

TIP It is usually easier to create solid models and avoid errors by turning shading on to reduce 
the visual clutter in 3D views.
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Control the Display Properties of Solid Models

Several system variables affect the display properties of solid models. The primary ones can 
be changed in the Options dialog box as shown here.

After changing any of these settings, use the REGEN command to see the effects.

NOTE For additional graphics display options, click the System tab. Click Performance Settings 
and then click Manual Tune. Alternatively, enter 3dconfig on the command line. These options 
are optimized automatically to your hardware, but you can also control the settings manually. 

VIEWRES

FACETRES

ISOLINES

DISPSILH
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ISOLINES controls the wireframe mesh density of all curved faces in a drawing. This setting 
applies to wireframe displays of solid models. The default value is 4, but typical values range 
from 0 to 16 depending on circumstances.

VIEWRES (view resolution) controls the smoothness of curved edges and isolines in 
wireframe displays of solid models. The default setting is 1000, but you can increase the 
setting even more. After changing the setting for VIEWRES, zoom in and out to see the 
difference.

ISOLINES = 4 ISOLINES = 8

VIEWRES = 20 VIEWRES = 100
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DISPSILH controls whether the silhouette edges of curved faces are included in wireframe 
displays of solid models.

TIP You can set ISOLINES to 0 and DISPSILH to 1 as a method of displaying solid models with a 
minimum number of wireframe display lines.

FACETRES (facet resolution) controls the smoothness of curved edges in shaded and rendered 
displays of solid models. The default setting is 0.5, but many people increase it to at least 2. 
After changing the setting for FACETRES, use REGEN or RENDER to see the difference.

DISPSILH = 1
ISOLINES = 0

DISPSILH = 0
ISOLINES = 2

Silhouette edges No silhouette edges

FACETRES = 0.1 FACETRES = 5
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Specify Precise Views

You can specify standard orthographic views such as front, right, top, and isometric from the 
3D Orbit shortcut menu. Within 3D Orbit, you right-click, and then choose one of the 
following:

■ For a front view: Preset Views > Front
■ For a right-side view: Preset Views > Right
■ For a top view: Preset Views > Top
■ For an isometric view: Preset Views > SE Isometric

The illustrated viewing directions are always relative to the world coordinate system (WCS), not 
the current user coordinate system (UCS). Furthermore, AutoCAD uses the architectural 
convention that defines the XY plane as the top or plan view rather than the mechanical 
design convention that defines the XY plane as the front view.

Top (plan) view: projected 
along the Z axis

Right side view: 
projected along the 
X axis

Front view: projected along 
the negative Y axis

0,0,0 (WCS)
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NOTE Preset views are also accessible from the dashboard, the View toolbar, and the View 
menu. However, choosing a preset orthographic view from these interface elements automatically 
changes the UCS so that the XY plane is parallel with the plane of your screen. This may not be 
desirable behavior in 3D modeling.

Try it:

1 In the \Help\buildyourworld folder, open the drawing 33 Stool.dwg.

2 Use the 3DORBIT command to set the viewpoints in the following illustration.

3 After you exit 3D Orbit, click View menu > Zoom > Previous to restore the previous view.

4 Leave the drawing open for now.

SE IsometricTop

RightFront
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TIP Check the fidelity of 3D models with orthographic views. It’s very easy to be fooled visually 
when working in 3D, as shown in the following illustration. 

However, the top view reveals that the 
circle is actually behind the object

The circle appears to be on the 
top face of the object.
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Use the Dashboard

The dashboard is a special palette that contains commands and settings for working in 3D. It 
eliminates the need to display many toolbars and reduces the clutter in the display area.

The dashboard displays automatically when you specify the 3D Modeling workspace. If you 
close the dashboard, you can redisplay it by clicking Tools menu > Palettes > Dashboard, or 
you can enter dashboard on the command line.

Try it:

1 If the dashboard is not docked on the side of the application window, dock the dashboard 
by dragging the title bar to the right side of the application window.

2 On the docked dashboard, in the upper-left corner, click the [-] button to anchor the 
dashboard. This turns on Auto-hide for the dashboard.

The dashboard rolls up conveniently to maximize the display area. It is highly 
recommended to keep the dashboard, the Tool Palettes window, and the Properties 
palette docked and anchored when you work.

X-ray Mode

Parallel Projection

Perspective Projection

Visual Styles

Click to expand or 
collapse control panel

Click to anchor the dashboard

Constrained Orbit 
(a 3D Orbit option)
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3 Move your cursor over the rolled-up dashboard to display it. Click each large control 
panel icon to expand or collapse each control panel. For several control panels, an 
associated tool palette displays automatically.

4 On the dashboard, click Perspective Projection, click the Visual Styles control, and then 
click Realistic from the drop-down list. See the previous illustration to help you locate 
these controls.

5 On the dashboard, click Constrained Orbit. Then click and drag the view in the drawing 
area.

6 On the dashboard, click X-ray Mode.

NOTE For best results, make sure that hardware acceleration is turned on. To access this 
setting, enter 3dconfig on the command line. In the Adaptive Degeneration and 
Performance Tuning dialog box, click Manual Tune. In the Manual Performance Tuning 
dialog box, click Enable Hardware Acceleration.

7 Click Constrained Mode. Click and drag the view in the drawing area.

Notice that the hidden edges and object snap locations are now easily accessible.

8 Press ESC to exit 3D Orbit. Close the drawing.
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Control the Workplane
What’s inside…
The XY plane of the user coordinate system (UCS) is called the work-
plane. For working in 3D, it is essential to become skilled at changing 
the location and orientation of the UCS.
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Understand the Role of Coordinate Systems

The coordinates of the world coordinate system (WCS) define the location of all objects and 
the standard views in AutoCAD drawings. However, the world coordinate system is 
permanent and invisible. It cannot be moved or rotated.

AutoCAD provides a movable coordinate system called the user coordinate system, or UCS. 
To create 3D solid models in AutoCAD, it is essential to become skilled at controlling the 
location and orientation of the UCS. 

The following illustration shows a partially designed plastic desk stand. The UCS is currently 
aligned with the world coordinate system. To construct objects on the face plate of the desk 
stand, you will need to align the XY plane of the UCS—the workplane—with the face plate.

Try it:

1 In the \Help\buildyourworld folder, open 
the drawing 41 Stand.dwg.

Notice that the 3D pointer uses the same 
colors as the UCS to represent the 
directions of the axes.

2 If the UCS icon is not displayed, click 
View menu > Display > UCS Icon, and 
then click both On and Origin. The Origin 
option makes the UCS icon appear at its 
origin (0,0,0) point within the drawing 
display if possible.

■ By convention, the X axis is red, the Y 
axis is green, and the Z axis is blue

■ The UCS is represented by a colorful 
3D icon visible in 3D views

■ The UCS is initially coincident with the 
world coordinate system

■ The UCS can be relocated easily to 
facilitate construction in 3D



Understand the Role of Coordinate Systems 29
3 For now, make sure that the DUCS (Dynamic UCS) button on the status bar is turned off 
(not depressed). You will use this feature later.

4 Click Tools menu > New UCS > 3 Point and specify the following point locations.

TIP It is very easy to click the wrong vertex on a relatively thin plate as in the previous steps. Use 
the zoom feature of a wheel mouse to magnify object snap locations that are in close proximity to 
each other.

4a Specify the new origin point 
at the endpoint of the lower-
left corner of the face plate.

4b Specify the orientation of the X axis at the endpoint of 
the lower-right corner of the face plate.

4c Specify the orientation of the 
Y axis at the endpoint of the 
upper-left corner of the face 
plate.
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In the following example, the rectangles and circle were created on the workplane. These 
objects can later be converted into solids and combined with the other solids. The objects 
were created and modified with familiar 2D commands.

The XY plane of the UCS has now been aligned 
with the face of the desk stand 

The origin point (0,0,0) is now located in the 
bottom-left corner

The XY plane of the UCS is also called the 
workplane and is useful as a construction plane

Planar objects such as the red construction 
lines, the rectangles, and the circle are 
automatically aligned with the workplane

Coordinate values, such as those of the center 
of the circle, are measured from the new UCS 
origin

The rectangles were easily rotated in the 
workplane—the axis of rotation is always 
parallel to the Z axis of the UCS

The circle and the rectangles can be used 
later to construct a hole and two slots in 
the face of the desk stand
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Try it:

1 With Polar or Ortho mode turned on, create a 30 mm line from the midpoint of the top 
edge of the face plate, as shown in the previous illustration.

2 Create another line that extends 35 mm to the left.

3 Create a circle with a 20 mm diameter centered at the intersection of the two previously 
created lines.

4 Create a 35 mm x 5 mm rectangle and rotate it 30 degrees as shown previously. Then 
mirror it to create a second rectangle. If you have trouble selecting the rectangle, set the 
3DSELECTIONMODE system variable to 0.

TIP You can specify a view of the XY plane of the current UCS with the PLAN command. This 
command is useful to confirm visually that the location of objects on the workplane is correct.

Try it:

1 Click View menu > 3D Views > Plan View > Current UCS.

2 Return to the previous view. Click View menu > Zoom > Previous.

You can easily return the UCS to be coincident with the world coordinate system. Click Tools 
menu > New UCS > World.
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Work with Other UCS Options

There are several situations where you need to align the Z axis of the UCS to rotate objects. 
For example, each of the doors on this toy house has a different rotation axis.

Use the ZAxis option of the UCS command to specify the Z axis directly.

Try it:

1 In the \Help\buildyourworld folder, open the drawing 42 Toy House.dwg.

The Z axis is already parallel to the hinge of the green door.

2 Start the ROTATE command, select the door, and specify the endpoint on the lower-left 
corner of the door as the base point. Move the pointer to swing the door open. 
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3 For the red garage door, click Tools menu > New UCS > Z Axis Vector to align the UCS Z 
axis with two endpoints along the outside top edge of the door. Be careful not to snap to 
the inside edge of the door. 

4 To swing the garage door open, start the ROTATE command, select the garage door, and 
specify the upper-left corner as the base point. Move the pointer to swing the garage door 
open.

5 Use the ZAxis option of the UCS to align the Z axis with the side edge of one of the blue 
storage doors.

This time, instead of moving the pointer to rotate these doors open, you will enter the 
value for an angle. 

However, to open the storage doors outward, you need to know whether the rotation 
angle should be positive or negative. By default, a positive angle means a counterclockwise 
rotation.
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An easy way to remember the rotation direction is to use the right-hand rule for rotation. 
Point the thumb of your right hand in the direction of the positive UCS Z axis. Your 
fingers will curl in the positive rotation direction.

NOTE Use your left hand if you set 
AutoCAD to interpret a positive angle as a 
clockwise rotation.

6 Rotate both blue doors 150 degrees 
outward. One of the doors must be 
rotated 150 degrees, the other one -150 
degrees.

7 Keep the drawing open.

TIP It is often useful to rotate the UCS 
90 degrees around one of its axes. In 
this case, use the X, Y, or Z options of 
the UCS command. Use the right-hand 
rule to determine whether the rotation 
should be positive or negative 90 
degrees.

Direction of 
positive Z axis

Direction of positive 
rotation angle



Use the Dynamic UCS Feature for Speed 35
Use the Dynamic UCS Feature for Speed

You can align the XY plane of the UCS, the workplane, quickly with the Dynamic UCS 
feature. When Dynamic UCS is turned on, commands that create planar objects, such as 
circles, arcs, and lines, automatically align the workplane with any existing plane based on 
the location of your pointer.

Try it:

1 Click the DUCS (Dynamic UCS) button on the status bar to turn it on.

2 Change the current layer to the 00 REFERENCE layer.

3 Start the CIRCLE command.

4 Move your pointer over several planes on the toy house.

Notice that the workplane aligns with each visible plane as your cursor passes over it. Also 
notice that the alignment and direction of the X axis depends on the edge of the plane 
over which your pointer passes and the closest vertex on that edge.

5 Click anywhere in each plane to create circles as shown in the illustration. Notice that 
after you exit the circle command, the UCS returns to its previous location automatically.

TIP You can also use the Dynamic UCS feature during the UCS command. This is a fast and 
reliable technique to make sure that the XY plane of the UCS is located exactly on the plane that 
you want to work on.
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Try it:

1 Start the UCS command.

2 To orient the X and Y axes as in the following illustration, move your pointer as indicated 
by the blue arrow so that it crosses the roof edge near the arrowhead.

3 Click near the vertex to cause the Endpoint object snap to locate the UCS origin at the 
vertex. Be careful not to cross another edge with the pointer.

4 Use this technique to locate the UCS with precision on several other planes.

5 Close the drawing file.

NOTE Turn off DUCS when you need to use object snap tracking (OTRACK) or polar tracking 
(POLAR).
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What’s inside…
To create basic 3D solid objects, you can extrude closed objects, such 
as closed 2D polylines, revolve them around an axis, or sweep them 
along a path. You can also create solids using primitives, which include 
boxes, cylinders, pyramids, and spheres.

Extrude 2D Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
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Extrude 2D Objects

One of the best things about creating solid models with AutoCAD is that you can start with 
2D drawings. For example, the floor plan illustrated below was extruded to form a 3D solid 
model.

After you create basic solids, you can then combine them with other solids to create more 
complex solids. For example, in the illustration, the window openings were subtracted from 
the solid walls. How to combine solids will be explained in the next chapter. It is important 
to become familiar with how to create basic solids first.

Direction of 
extrusion

House floor plan Extruded model



Extrude 2D Objects 39
Try it:

1 Open the drawing 51 Campus.dwg. 

This is a plan view of part of a university to be used for a massing study for a new library. 

2 Use 3D Orbit to obtain an isometric view. Right-click and set the projection style to 
Perspective.

3 Locate and zoom into the site for the new library.

Notice that the foundation of the building is composed of lines and an arc. To extrude 
these as a single object, they need to be joined together into a single 2D polyline. To do 
this, you can use the Join option of the PEDIT command, or you can use the much faster 
BOUNDARY command.

4 Change the current layer to 32 LIBRARY and zoom into the lines and arc of the library 
foundation.

5 Turn off the following layers: 20 CURBS AND WALKWAYS, 21 LANDSCAPE, 30 
BUILDINGS, and 31 ATHLETICS.

6 On the command line, enter boundary.

Foundation of the 
proposed library
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7 In the Boundary Creation dialog box, clear the Island Detection box. Then click Pick 
Points and click anywhere within the outline of the library foundation. After the 
boundary is displayed, press ENTER to end the command.

A closed 2D polyline in the shape of the library foundation is created on the current layer, 
32 LIBRARY. The original lines and arc are still on the 03 FOUNDATIONS layer to use later 
if needed.

TIP Turn off unnecessary layers and zoom into the area of the boundary to be created. This 
speeds up the operation by reducing the number of objects to be processed. Always make sure 
that the XY plane of the UCS is in the same plane as the objects to be used to create the 
boundary.

8 Turn the 03 FOUNDATIONS layer off.

9 Click Draw menu > Modeling > Extrude and select the polyline. Enter 62 as the height 
and press ENTER to specify a 0 degree taper angle.

10 Turn the 03 FOUNDATIONS, 20 CURBS AND WALKWAYS, 21 LANDSCAPE, 30 
BUILDINGS, and 31 ATHLETICS layers back on.

11 Zoom out to see the overall effect. Keep the drawing file open.

A basic 3D representation 
of the building is now 
visible.

Note that the 2D polyline 
was deleted in the process 
of extruding the building. If 
you want to retain the 2D 
objects that generate 3D 
solids, you can set the 
DELOBJ system variable to 
0 (off).

TIP Solid objects created 
from 2D polylines or regions 
are always created on the 
current layer, not the layers 
of the original 2D objects.
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Extrusions don’t all have to be “upward.” It is often useful to extrude objects “sideways.” This 
is how the kitchen stove and the stool used in previous illustrations were created.

Kitchen stove from 31 Kitchen.dwg

Direction of extrusion of 
closed polyline

Stool from 33 Stool.dwg

Direction of extrusion 
of circles to form the 
base and column

Direction of extrusion 
of closed polyline to 
form the seat
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For example, you can create a steel storage building for this campus using this method.

Try it:

1 Zoom in on the existing storage building and delete it.

2 Set the current layer to 30 
BUILDINGS. Turn off the layers 
10 BASE, 21 LANDSCAPE, and 20 
CURBS AND WALKWAYS.

3 On the command line, enter 
boundary.

4 In the Boundary Creation dialog 
box, clear the Island Detection 
box. Then click Pick Points and 
click anywhere within the outline 
of the storage building profile. 
After the boundary is displayed, 
press ENTER to end the 
command.

5 If necessary, click the DUCS button on the status bar to turn it off.

6 Click Tools menu > New UCS > Z Axis Vector.

Click within this area
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7 Specify the Z axis of the UCS by clicking two endpoints as illustrated.

8 Select the polyline boundary of the storage building and then rotate it 90 degrees as 
illustrated.

7a New origin point

7b Point on positive Z axis

8a Base point

8b Rotate 90 degrees
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9 Move the polyline boundary into place onto the edge of the building foundation using 
object snaps as illustrated.

10 Click Draw menu > Modeling > 
Extrude and select the polyline 
boundary. Enter 105 as the length.

11 Turn the 10 BASE, 21 LANDSCAPE, and 
20 CURBS AND WALKWAYS layers 
back on to see the storage building in 
context. Turn off the 
03 FOUNDATIONS layer, which 
contains the building footprints in this 
drawing.

12 Close the drawing.

NOTE There may be an additional prompt 
whether to delete the extruded objects 
depending on the setting for the DELOBJ 
system variable.
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Revolve 2D Objects Around an Axis

In addition to extruding 2D polylines, circles, ellipses, and regions in a linear direction, you 
can also create 3D solid objects by revolving them around an axis. For example, let’s say you 
need a dramatic illustration to advertise a new bicycle rim. You want the result to look like 
this.

To create the 3D solid, you start with the 2D section of the bike rim. Once you locate the axis 
of revolution, you can revolve the section up to 360 degrees.

Try it:

1 Open the drawing 52 Bike Rim.dwg.

2 Click Tools menu > Inquiry > Distance and verify the length of the dark blue line. This 
line represents the distance between the outside edge of the rim and the red centerline of 
the hub of the wheel. The radius of the bike rim is 311 mm.

TIP When working in 3D, it is an excellent idea to check coordinates, distances, and lengths 
of objects frequently.
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3 Click Draw menu > Modeling > Revolve. Select the bike rim section and then specify the 
endpoints of the red axis of revolution as illustrated.

4 For the angle of revolution, enter 30 degrees.

5 Turn off the 00 REFERENCE layer. You can turn off the display of the UCS icon by clicking 
View menu > Display > UCS Icon, and clearing the On item.

6 Use 3D Orbit to experiment with visual styles, perspective projection, and viewing angles.

7 Close the drawing file.

Second endpoint of the axisFirst endpoint of the axis
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In some circumstances, you will need to revolve an object around an axis that is internal to 
the solid. In this case, you revolve only half the profile around the axis as shown in the 
following drawing of a glass.

Result of revolving 360 degreesHalf profile of glass

Axis of revolution
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Try it:

1 Open the drawing 53 Glass.dwg.

2 Revolve the profile 360 degrees around the endpoints of the centerline of the glass.

TIP Sometimes snapping to an endpoint when you specify an axis involves locating an object 
in an area that is densely populated with other objects. Instead of zooming in to the endpoint, 
you can often save time and avoid errors by using a midpoint object snap instead.

3 Use 3D Orbit to change the visual style and view of the glass.

4 Enter -shademode on the command line and specify Gouraud. Click the X-ray Mode 
button on the dashboard. Use 3D Orbit to view the glass.

5 Close the drawing file.

Axis of revolution

2a Axis endpoint

2b Axis endpoint

2c Enter 360
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Sweep 2D Objects Along a Path

You can create a solid by sweeping a circle, rectangle, or other closed 2D object along a 2D or 
3D path. This is an efficient method to use when you create rails, pipes, tubes, and ducts.

Try it: 

1 Open the drawing 54 Chair.dwg.

2 Delete the metal tubes as illustrated.

3 Turn on the 00 REFERENCE layer. The defining 2D polylines and circle are now visible.

4 Change the DELOBJ system variable to 0 (off). This setting retains the defining geometry 
for the sweep operation that follows.

Delete these tubes



50 Chapter 5 Create Basic Solids
5 Click Draw menu > Modeling > Sweep. Select the circle and press ENTER.

6 Select the sweep path as illustrated. The circle is not deleted.

To create the diagonal brace, you can sweep the same circle along the diagonal polyline. 
You do not have to align the circle with the path!

Circle

Select the 2D polyline as the 
sweep path



Sweep 2D Objects Along a Path 51
7 Repeat the SWEEP command and use a window selection to select the circle (enter w at 
the Select Objects prompt). This is necessary because the circle is “under” the solid tube 
and cannot be selected directly. Then select the remaining polyline as the path.

8 Take some time to experiment with sweeping your own closed objects along different 
paths.

9 Close the drawing file.

Select the 2D polyline

Use Window selection 
to select the circle
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Use Primitives

A more spatially oriented method of creating solids is to model starting with solid primitives—
boxes, pyramids, cones, cylinders, and so on.

All of these primitives are listed on the Draw > Modeling menu and on the dashboard in the 
3D Modeling workspace. They are easy and intuitive to use.
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Try it:

1 Open the drawing 51 Campus.dwg.

2 Zoom into the upper-left corner of the model and use 3D Orbit to display an isometric 
view.

Some enterprising but mischievous engineering students have dismantled and removed 
a famous sculpture from its circular pad.

You have been commissioned to create a new sculpture in its place.

3 Use solid primitives to make a creative and colorful replacement. Don’t forget to change 
the orientation of the UCS workplane to orient several primitives.

4 Close the drawing file.

Missing sculpture
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Create Landscaping

Landscaping presents a special challenge to architectural models. It is not necessary or 
advisable to model a tree or shrub down to its leaves and twigs. Thus, there are several choices 
regarding the appropriate type and level of abstraction that you can use. Consider the 
following:

■ Landscaping is typically meant to convey an effect or idea without drawing unnecessary 
attention to itself and away from the architecture.

■ 3D landscaping can be used to check views and visual interferences.
■ Excessive detail will make a model unnecessarily large and will slow performance.
■ Excessive abstraction will draw attention to unlikely looking landscaping.

The following illustration shows several techniques for creating trees or shrubs.

Try it:

1 Open the drawing 55 Trees.dwg.

2 Use 3D Orbit to view the tree representations from different angles, including the top.

3 Try creating your own version of a tree.

4 Open the drawing 51 Campus.dwg.

“Asterisk” trees 

“Extruded” tree, 
chamfer top

“Lollipop” tree

“Extruded” tree

“Composite” tree
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5 Zoom into the lower-left corner of the campus model and use 3D Orbit to view the 
“asterisk” trees inserted along the university entrance.

These trees were created by tracing an imported image in AutoCAD and then converting 
the polylines into regions. Four regions were copied and rotated to create an asterisk 
pattern when viewed from the top. The result was saved as a block.

6 Copy the trees to other locations on campus.

7 Experiment with other styles of trees or make more of your own.

TIP After creating a tree, save it as a block. This reduces the size of a drawing if you insert the 
block multiple times.
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To create some simple shrubs, you can extrude closed splines.

1 Zoom into the area of the sign that is visible in the lower-left corner of the campus. If 
necessary, use 3D Orbit to adjust the viewing angle.

2 Set the current layer to 21 LANDSCAPE.

3 If necessary, open the Properties palette.

4 Using the Properties palette, override the BYLAYER color to a darker shade of green.

5 Click the DUCS button on the status bar to turn on Dynamic UCS.

6 Start the UCS command, click the grass area near the sign, and press ENTER. This locates 
the XY plane of the UCS on the surface of the grass.

7 Click the DUCS button on the status bar to turn off Dynamic UCS.

8 Draw several closed splines and extrude them 2 feet to create areas covered by shrubs. 

When creating the splines, turn off object snaps and change to a more nearly vertical 
view.

9 Close the drawing file.

Extruded closed splines
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What’s inside…
To merge 3D solids, you can use Boolean operations such as Union and 
Subtract. You can create new solids from the intersecting volumes of 
existing solids, and you can also relocate faces and edges of solids.

Add and Subtract Solids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
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Add and Subtract Solids

After you create 3D solids, you can join them together with Boolean operations such as Union 
and Subtract. For example, to create keyhole slots in a panel, you subtract the keyholes from 
the panel, as shown in the illustration—the keyholes were extruded a greater distance than 
necessary to make them easier to see and select.

You can also use Boolean operations to combine several 2D region objects into a single region 
before extruding them. For example, the rectangles in the following illustrations were first 
converted into regions and then combined.

NOTE Edge and face colors of 2D regions and 3D solids are retained after Boolean operations.

Try it:

1 Open a new drawing and display a 2D plan view.

2 On the command line, enter delobj. Make sure it is set to 1 (on).

3 Create several overlapping closed polylines, rectangles, and circles.

Original polylines Extruded solids Result after subtraction

Two regions Union the red and 
blue regions

Two regions Subtract the green region 
from the red region
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4 Click Draw menu > Region and select all the objects you created. 

5 Press ENTER.

These objects have now been converted into region objects.

6 Click Modify menu > Solid Editing > Union and select two overlapping objects.

7 Click Modify menu > Solid Editing > Subtract.

8 Select another object and press ENTER.

9 Select an overlapping object that you want to subtract from the previously selected object 
and press ENTER.

Notice that the SUBTRACT command works like the TRIM and EXTEND commands in that 
they use two selection sets: the objects to keep and the objects to subtract from them.

In the following illustration of the Subtract operation, the red and blue regions are selected 
first. Then the green region is selected to subtract from the first two regions. The result 
combines the three rectangles into a single region.

Try it:

1 Create three regions as shown in the illustration. Use RECTANG and then REGION.

2 Click Modify menu > Solid Editing > Subtract.

3 Select two overlapping regions and press ENTER.

4 Select another overlapping region and press ENTER.

5 Try several more examples using circular, rectangular, and polygonal regions.

6 Extrude or revolve the resulting complex region as a single object.

TIP You can create solid models efficiently by combining regions in 2D and then extruding, 
revolving, or sweeping them in 3D.

Three regions Result after subtraction
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The 2D section of a bicycle rim in the previous chapter was created using this method.

The Union and Subtract operations work identically with 3D extrusions and primitives.

Exterior boundary converted into a 
region with the BOUNDARY 
command

Interior holes converted into 
regions and subtracted from the 
exterior region
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Try it:

1 Open the drawing 61 Hall.dwg.

This is the beginning of a gray-colored massing model of a concert hall.

TIP Avoid using index color 7, White, for solids. Objects created with index color 7 display as 
black or white depending on the current background color. For white objects, use a True Color 
setting of 255,255,255 instead.
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2 Subtract the top cylinder from the large box.

3 Union the remaining cylinder and the complex solid.

4 Subtract the small box from the complex solid.
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5 Undo all your previous steps and see whether you can get the same result with a single 
subtract operation.

TIP There are two selection sets in the SUBTRACT command.

6 Close the drawing file.

There are usually several ways to create any solid model. For example, the couch in the 
illustration could have been created using primitives and a series of Union operations. It is 
easier in this case to use a Subtract operation.

Try it:

1 Open the drawing 62 Couch.dwg.

This drawing contains two solids: a box primitive and an extruded trapezoidal polyline.
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2 Move the extruded solid onto the box as illustrated, using Midpoint object snaps.

3 On the command line, enter 3dselectionmode and then enter 0. This enables you to 
select the object you moved, which is now inside the box primitive.

4 Subtract the extruded solid from the box primitive. After you start the Subtract operation, 
select the box, press ENTER, and then select the extruded object. The basic shape of the 
couch is complete.

5 Before creating the cushions, set the current layer to 20 CUSHION.
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6 Create a box using the object snaps shown in the illustration and give the box a height of 
150 mm.

7 Set the UCS working plane on the angled face of the couch using the Face option of the 
UCS command. Click near the upper-left corner of the couch.

8 Create a box on the working plane starting at the origin point with a length of 815 mm, 
a width of negative 330 mm, and a height of 150 mm.



66 Chapter 6 Combine and Modify Solids
9 Move the box along the Y axis as illustrated. Then return the UCS to its previous (WCS) 
location.

10 Turn off layer 10 COUCH.

11 Change the visual style of the couch to 3D Wireframe. Use the FILLET command to round 
all 12 edges of each cushion with a fillet radius of 30 mm.

TIP To make sure that the corners of solids blend correctly, select all intersecting edges of 
each object in a single FILLET command.

12 Turn layer 10 COUCH back on.

Move the box 42 mm in the 
positive Y direction
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13 Use object snaps to copy the seat and back cushions as illustrated.

14 Turn off layer 20 CUSHION.

15 Round the corners of the couch as illustrated. Use a fillet radius of 30 mm.

TIP Delay filleting and rounding edges until the very end. You will find that sharp edges and 
corners are often needed as reference locations to create, move, copy, and mirror other 
objects.

16 Turn layer 20 CUSHION back on.

17 Change the visual style to Realistic or enter -shademode to specifiy Gouraud.

18 Use 3D Orbit to view your completed model.

19 Turn layer 30 PILLOW on for a special touch.

20 Close the drawing file.
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Intersect Extruded Profiles

Another powerful Boolean command is INTERSECT. Intersect operations create solid objects 
from the common volumes of overlapping solids. There are several efficient construction 
techniques that use Intersect operations. For example, you can easily create the bracket from 
an old-fashioned bow sight used in the sport of archery by intersecting the extruded 2D 
views.

Try it:

1 Open the drawing 63 Bowsight.dwg.

2 Use the BOUNDARY command to create regions out 
of each of the closed loops in the drawing. In the 
Boundary Creation dialog box under Object Type, 
click Region from the drop-down list. Click Pick 
Points and click in the areas as shown in the 
illustration.

Click in these areas
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3 Use the SUBTRACT command to subtract the three slots from the bracket. You should be 
left with two region objects: a top profile and a front profile.

4 Use 3D Orbit to display a 3D view of the bracket.

5 Turn off the layers 10 FRONT and 20 TOP. You used the objects on these layers to create 
the profiles on the current layer, 30 SOLID. 

TIP Always retain 2D reference geometry and construction lines. These objects will be very 
handy for future additions and changes. Whether these objects are retained or deleted 
depends on the setting of the DELOBJ (delete object) system variable.

6 Align the Z axis of the UCS with the red reference line and rotate the top profile 90 
degrees as illustrated.
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7 Extrude both profiles. To specify the extrusion distance, click a starting point and move 
the pointer. The exact distance does not matter, only that the extrusions pass completely 
through each other.

8 Start the INTERSECT command, select both extrusions, and press ENTER.

9 The bracket model is complete. Use the 3DORBIT command to specify different visual 
styles, projections, and viewpoints.

10 Close the drawing file.
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Another example of intersecting two extruded profiles is shown in the following illustration 
of a hip roof. You can examine the model in detail and try out the technique by opening the 
drawing 64 Roof.dwg.

The next illustration shows how you can create a plastic box with a two-degree draft angle. 
In this example, two closed polylines, an interior one and an exterior one, were created for 
each profile. You can examine the model in detail and try out the technique by opening the 
drawing 65 Box.dwg.

Extrude two profiles Intersect the extrusions Result

Extrude four profiles Intersect the two interior 
extrusions and then the two 
exterior extrusions

Subtract the interior 
solid from the exterior 
solid

Result
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This same technique can be extended to three profiles. For example, to create a massing 
model of a museum, you can intersect the extrusions of the front, top, and side elevations. 
The steps in the process are displayed in the following illustration.

Try it:

1 Open the drawing 66 Profiles.dwg.

2 Extrude the elevations and foundation plan so they completely cross through each other.

3 Use the INTERSECT command to create the massing model.

4 Close the drawing file.

Many municipalities are beginning to require massing models as a part of the building design 
approval process. Some municipalities also require a second, more detailed 3D model.

The following illustration is another example of the intersection technique that was used to 
create the bottle in the 66 Bottle.dwg drawing.

Foundation plan 
and two 
elevations

Rotate the 
elevations into 
place

Extrude the 
profiles through 
each other

Intersect the 
three 
extrusions

Reference objects Extruded solids Intersected solids
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The final result was obtained through the union of the neck with the body of the bottle, 
rounding the edges with the FILLET command, and then hollowing the result with the Shell 
option of the SOLIDEDIT command. Finally, a small cylinder was subtracted from the top of 
the neck to create an opening into the hollowed interior of the bottle.

Be careful to use reasonable radius values for the FILLET 
command. If the radius you specify is too large, the 
command will fail to round or fillet the solid.

Final result after rounding edges
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Control the Level of Detail

Every object that you model in AutoCAD can be constructed at different levels of detail. As 
you become skilled at creating solid models, you will be tempted to add more detail than 
necessary. For example, consider your computer keyboard. Notice the rounded edges, 
grooves, and curves. If you wanted to create a 3D model of the keyboard, how much detail 
should you include?

The answer depends on the intended purpose of the model. If the model is part of a 
representation of a furniture layout, less detail is needed. If the model is part of a detailed 
rendering for an advertisement, or for output to stress analysis software, much more detail is 
required.

Try it:

1 Open the drawing 67 Keyboards.dwg. This drawing contains two representations of a 
keyboard, a low-detail version and a moderate-detail version.

2 Zoom into each keyboard model. Use 3D Orbit to view each model from several angles.

3 Zoom out to the point where both models appear about the same.

4 Close the drawing file.

Anyone want to volunteer to put the letters on the keys?

The concept of controlling detail extends to methods of model construction. For example, 
here are two representations of part of a staircase. Which model is better?

Low detail Moderate detail
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Again, the answer depends on what you ultimately need:

■ A conceptual model for design and visualization or 
■ A detailed model for rendering, checking for interferences, or construction notes.

Try it:

1 Open the drawing 68 Stairs.dwg. This drawing contains two representations of a small 
staircase, a low-detail version and a high-detail version.

2 Use 3D Orbit to view each model from several angles.

3 Close the drawing file.

Extruded “sideways” from a 
simple polyline profile

Modeled from components to 
mimic construction
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Use Detail to Control Attention

Another factor to consider involves using variations in detail level to draw attention. You can 
draw attention to an area of a model by increasing the level of detail in that area and reducing 
the level of detail in the surrounding area. The attention of your audience will be naturally 
drawn to the area of greater detail. 

For example, in the following illustration, consider whether this image is best suited for 
presenting a new hanging cabinet design, or for presenting the placement of a down-draft 
stovetop and new lighting. What did your eye land on first?
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In the following illustration, the level of detail has been kept uniform and low. The purpose 
is to ensure that the intended audience grasps the overall spatial effect and is not distracted 
by choices of materials or minor detail.

Compare the previous illustration of the room to the following rendering. What do you find 
your attention drawn to in the rendering?
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The same principle applies to placing images of people in a model. To avoid distracting 
attention from your design to the clothing or expressions on the people, use outlines or 
translucent images of the people instead.

TIP Always remind yourself that a 3D model is a tool to achieve a purpose. Too much detail 
requires additional cost in time and performance. You can use detail to focus attention on a specific 
area of a drawing, or you can homogenize the detail in a drawing to convey an effect.
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What’s inside…
Solid models have a wide variety of uses, which include generating 
views for drawings, analyzing designs, and creating presentations.
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Where to Go From Here

Once you create a solid model, you can use it for a variety of tasks and applications. With a 
solid model, you can do any of the following:

■ Edit the edges, surfaces, and other subcomponents
■ Create sections for analysis, visualization, and drawings
■ Flatten 3D views into 2D views
■ Calculate mass properties such as area or volume
■ Check for visual or physical interferences
■ Create files for stereolithography or numerical control manufacturing
■ Perform 3D walkthroughs or flyovers
■ Make 3D solids transparent or translucent
■ Perform lighting studies and generate shadows
■ Create presentation images using lights, materials, and textures
■ Create photorealistic renderings

Some of the tasks listed will be of interest to you, while others are not relevant to your 
discipline. The following sections provide you with a short description of these tasks along 
with several illustrations and examples. References to the User’s Guide are listed at the end of 
each section for additional study.
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Edit Subobjects and Component Objects

By pressing CTRL as you select a solid, you can select subobjects and component objects in a 
3D solid. Subobjects include edges and planar surfaces. Component objects include 
primitives and other solids that are combined with Boolean operations to form a complex 
solid. You can also edit a solid using grips to change its dimensions.

Editing subobjects and components is best suited for conceptual design. Using these features, 
you typically do not specify distances and angles with precision. Instead, you focus on visual 
and spatial effects by stretching, moving, pressing, and pulling the components of a solid 
model.

Try It

1 Create a model from several primitives and combine them with a Boolean operation such 
as UNION or SUBTRACT.

2 Specify a 3D isometric view and specify either the Conceptual or Realistic visual style.

Grips are displayed on 
a box primitive

An edge subobject is 
selected on the box

Two component 
objects are 
contained in this 
combined solid

Press and pull a face
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3 Enter presspull and move your cursor over one of the faces of the solid. You can also start 
PRESSPULL from the dashboard. It is located near the center of the 3D Make control 
panel.

4 Click and then drag the surface forward and back. As you drag the face, the color of the 
face is set temporarily to the current color.

5 Click to accept the change.

Further Study in the User’s Guide

Manipulate 3D Solids and Surfaces

Press or Pull Bounded Areas

Select and Modify 3D Subobjects

Use Grip Tools to Modify Objects

Before pressing or pulling Face is pulled, colored area indicates change
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Create Sections

You can use several approaches to create sections. With “destructive” sectioning, you 
typically copy the solid model to its own layer or to a separate drawing file and then subtract 
another solid from your model to create the section view.

Try It

1 Open the drawing 71 Florett.dwg. This is a solid model of an electric foil point used in the 
sport of fencing, but the interior components are not visible.

2 Move your cursor over the foil point. Notice that the components have been associated 
into several groups. Set the PICKSTYLE system variable to 0. This allows you to select 
grouped components individually.

TIP When you need to combine several 3D solids, but you do not want to combine them 
with a Union operation, assign the solids to one or more groups.

3 Turn off layer 10 BARREL.

Notice the interior components. Turn off several other layers to explore the design.

4 Turn off all layers except 10 BARREL and 01 BOX.

5 Subtract the box from the barrel. Turn on all layers except the 00 REFERENCE layer.

6 Use 3D Orbit to view the sectioned model.

To get a better section view, you could make a copy of the box to be subtracted, perform 
a Subtract operation, and then repeat for each component. If you subtract the box from 
all the components in one Boolean operation, it will combine the results into a single 
solid, which is usually not what you want to do.

7 Open the drawing 72 Florett-S.dwg. This model is the result of repetitive subtractions on 
many of the components.

Destructive sectioning of a solid model 
using multiple Boolean subtractions
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8 Use 3D Orbit to view the model from several angles.

9 Close both drawing files.

TIP For destructive sectioning, you can create any solid shape—simple or complex—as the sub-
tracting volume.

In contrast, you can create a “live” section that does not alter the model and can be easily 
relocated. To create a live section, you use the SECTIONPLANE and LIVESECTION 
commands. With the Draw option, you can specify a series of section lines.

Further Study in the User’s Guide

Create Sections and 2D Drawings from 3D Models

Create Solids by Slicing

Nondestructive, live sectioning of a 
solid model including a jog

Hatching can be assigned automatically

Jog in section plane
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Flatten 3D Views

Normally, when you finish creating a solid model, you define several standard views on a 
layout, and the model provides these views in a visual style that you specify with no extra 
work needed before plotting.

However, you might encounter situations where you need a static 2D projection of a model 
for the purpose of modifying or hatching it. 

You can choose from several commands that create static 2D projections.

■ The SOLPROF command creates a 2D projection of the visible edges of a solid on a 
viewport-specific layer—a layer visible in only one specified viewport. Another viewport-
specific layer includes only the hidden lines, also in 2D. All resulting edges are combined 
as blocks. A dashed linetype can be assigned to the hidden edges.

■ The FLATSHOT command produces a result similar to SOLPROF, but the results are created 
on the current layer and on the XY plane of the UCS. The result is visible in all viewports. 
This is a very handy tool for creating a quick 2D snapshot from any viewpoint.

■ The SECTION command creates a 2D region on the current layer defined by a section 
plane that is specified with three points.

■ The SECTIONPLANE command creates a block that contains a 2D hatch object. The 
section plane is defined by at least one line—the section plane contains the line and is 
perpendicular to the XY plane of the UCS.

Try It

1 Open the drawing 33 Stool.dwg.

2 Enter ucs on the command line and specify the View option. This orients the UCS XY 
plane, which is the projection plane for FLATSHOT.

3 Enter flatshot and accept the defaults in the Flatshot dialog box. FLATSHOT is also 
available on the dashboard in the lower-right corner of the 3D Make control panel.

4 To locate the block, click a point on the XY plane and press ENTER to accept all default 
values.

5 Explode the block and delete some of the 2D objects that would normally be hidden. 

6 Close the drawing file.

You can experiment creating flattened blocks from other drawings such as the 66 Bottle 
drawing or the 71 Florett drawing.

Further Study in the User’s Guide

Create a Flattened View



86 Chapter 7 Put Your Work to Use
Calculate Mass Properties

You can use the MASSPROP and AREA commands to obtain mass and area data from a solid.

For example, assume that the small bottle that you worked with in chapter 3 is made of 
polyethylene with a specific gravity of 0.92 (cgs units). The volume of the polyethylene is 
4.38 cubic centimeters. (The bottle is about 8 cm tall.)

NOTE Because the MASSPROP command 
does not “know” the specific gravity of the 
material used or the units of measurement, it 
assumes a specific gravity of 1.00 and so the 
computed mass is always the same as the 
computed volume.

Thus, the mass of the polyethylene is 4.38 
cm3 x 0.92 = 4.03 grams.

Try It

1 Open the drawing 66 Bottle.dwg.

2 Enter massprop and select the bottle.

3 Scan through the mass property report. 
Press ESC.

4 Enter area and specify the Object option.

5 Select the bottle to display the surface area of the bottle, both external and internal.

6 Close the drawing file.

How would you obtain the external area or the internal volume of the bottle? In each case, 
you need the solid, unshelled version of the bottle. This is an example of why it is a good idea 
to save intermediate stages of each model.

Another useful application of MASSPROP is computing the centroids of rotating parts such 
as cams.

Further Study in the User’s Guide

Extract Geometric Information from Objects
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Walk Through or Fly Over 3D Models

The 3D Walk and 3D Fly features provide a way to gain a better 3D “feel” for interiors and 
exteriors of structures and other models.

For your convenience, the 3DWALK and 3DFLY commands are accessible from several places 
in the user interface.

■ On the dashboard, locate the 3D Navigate control panel. The Walk, Fly, and Walk and Fly 
Settings buttons are available from a flyout on the top row.

■ In 3D Orbit, right-click to display the shortcut menu. Click Other Navigation Modes and 
then click Walk or Fly.

■ In 3D Orbit, press 6 to walk or 7 to fly.
■ On the View menu, click Walk and Fly. Then click either Walk or Fly.
■ Enter 3dwalk or 3dfly on the command line.
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Try It

1 Open the drawing 51 Campus.dwg.

2 With the 3DORBIT command, specify an isometric view. Right-click to display the 
shortcut menu. Turn on Perspective mode and exit the command.

3 Enter 3dfly on the command line. You can press F1 to see all of the command access 
options that are available.

4 Use the arrow keys to fly over the campus. Click and hold the mouse button to steer. The 
keyboard controls are similar to those in many computer games. Press ESC to exit.

5 Close the drawing file.

Try It

1 In the \Sample folder, open the drawing 3DHouse.dwg.

2 Turn on Perspective mode from the 3D Navigate control panel on the dashboard.

3 Enter 3dwalk on the command line and take a tour of the house.

4 Close the drawing file.

Further Study in the User’s Guide

Walk and Fly Through a Drawing
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Check for Interferences

Before they become a serious and expensive problem, you can check for interferences either 
visually or with the Boolean INTERFERE command. The following are real-world examples.

■ In 73 Eclipse.dwg, the interference between the LEDs and the label of this electronic scoring 
machine used in the sport of fencing was discovered in time to add a spacer that solved 
the problem. 

■ In 74 Duct.dwg, the construction of this school building was in progress when it was 
discovered that a structural steel brace was going to interfere with a duct.

Try It

1 In the \Help\buildyourworld folder, open the drawing 73 Eclipse.dwg.

2 Insert the block, 1PCBoard, into the case using the Center object snap as shown. (The 
circuit board is already saved as a block definition in the drawing.)

The insertion point is the center point 
of the top of the standoff
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3 Use 3D Orbit to rotate the view of the scoring machine. Notice that the LED lights are 
poking through the plastic label.

4 Restore the previous isometric view. (You can use Undo, Zoom /P, or 3D Orbit.)

5 Delete the circuit board block.

6 Turn on the layer, 37 SPACER. The four spacers increase the distance between the circuit 
board and the front of the case by just the right amount.

7 Insert the block, 1PCBoard, on top of the spacer, using the Center object snap as shown. 
You should zoom in to make sure that you snap to the center of the spacer.

The LEDs poke through 
the label

The insertion point is the 
center point of the top of the 
white spacer
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8 Use 3D Orbit to rotate the scoring machine until you can see the front label. Notice that 
the LED lights are no longer protruding.

9 Close the drawing file.

Try It

1 In the \Help\buildyourworld\ folder, open the drawing 74 Duct.dwg.

2 Use 3D Orbit to specify the Realistic visual style. Then rotate the view as shown below and 
exit 3D Orbit.

3 Make sure that PICKSTYLE is set to 1.

4 Enter interfere on the command line.

5 Select the diagonal brace and press ENTER. Select the dark green duct and press ENTER.

Diagonal brace

Duct
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6 In the Interference Checking dialog box, clear the Delete Interference check box. Click 
Close.

7 Change the visual style to 3D Wireframe.

8 Use 3D Orbit to view this typical problem area.

9 Close the drawing file.

Further Study in the User’s Guide

Check for Interferences within a Solid Model

Interference volume
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Create Files for Manufacturing

The information in a solid model can be extracted for manufacturing. The following 
aluminum case was modeled in AutoCAD. Then, a prototype of this case was manufactured 
in a few weeks without the use of any paper drawings.

Starting with the solid model, the engineer followed these steps:

■ In AutoCAD, the ACISOUT command was used to create an SAT file with the essential data 
of the case derived from the solid model. The ACIS file was sent by email to a 
manufacturing company.

■ The manufacturing company imported the ACIS file into their metal-folding software, 
which added the required bend radii.

■ Their software created an NC (numerical control) file that was sent to a flatbed laser 
cutting machine. The laser cutting machine cut out the part from an aluminum sheet.

■ The part was folded into shape and given a powder coat.
■ The engineer noticed some potential problems that required a new prototype.

Try It

1 In the \Help\buildyourworld\ folder, open the drawing 75 Case.dwg.

2 Use 3D Orbit to view the case from several angles.

3 Enter acisout on the command line and select the case to create an ACIS file.

4 Open and scan through the resulting SAT file in a text editor such as WordPad.

5 Close the text and drawing files.

Further Study in the User’s Guide

Export ACIS Files

Aluminum case manufactured from an 
AutoCAD drawing file
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Make 3D Solids Transparent

Reducing the opacity of solid models is a useful tool both for presentation and modeling. You 
can control the transparency of 3D solids with the Opacity control in the Materials window. 
If a material is assigned to each 3D solid in a model, you can control the opacity of each 3D 
solid individually.

Try It

1 In the \Help\buildyourworld folder, open the drawing 73 Eclipse.dwg, or in the \Sample 
folder, open the drawing 3D House.dwg. If you chose the Eclipse drawing, turn on the 37 
SPACER layer and insert the block 1PCBoard, as you did previously.

2 Enter materials on the command line or, on the dashboard, in the Materials control 
panel, click the Display Material Window button.

3 At the top of the Materials window, one or more materials are displayed on swatches. If 
you opened 3D House.dwg, make sure that the current material is set to Roof. Click the 
blue-gray swatch that displays the Roof In Use tooltip.

4 On the Materials window, adjust the Opacity slider to a value of 24. If you are using 3D 
House.dwg, click on other materials such as Interior Texture and Exterior Textures. On the 
Materials window, adjust the Opacity slider for each of these.

NOTE For best results, make sure that hardware acceleration is turned on. To access this 
setting, enter 3dconfig on the command line. In the Adaptive Degeneration and Performance 
Tuning dialog box, click Manual Tune. In the Manual Performance Tuning dialog box, click 
Enable Hardware Acceleration.

5 Using 3D Orbit, make sure that the current visual style is set to Realistic and rotate the 
model. Try entering -shademode on the command line and specifying Gouraud.

NOTE A faster method is available on the dashboard to set the opacity for all materials. 
Simply click the X-ray Mode button on the Visual Styles control panel.

6 Close the file.
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Further Study in the User’s Guide

Shade and Color Faces

Create and Modify Materials

73 Eclipse.dwg with opacity decreased

3D House.dwg with opacity decreased
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Create Realistic Images for Presentation

With a powerful set of lights, cameras, materials, and texture maps, you can set up a virtual 
studio within a 3D solid model. For a quick rendering, use the RENDER command. The preset 
values will produce reasonable results.

Try It

1 In the AutoCAD \Sample folder, open the drawing 3D House.dwg.

2 Turn off layer A-Roof and specify an interesting view, as shown in the illustration.

3 Enter render on the command line or, on the dashboard, on the Render control panel, 
click the Render button. Click Continue to ignore any missing texture maps.

The model is rendered in the Render window. From the Render window, you can save the 
resulting image in several formats by clicking File and then Save.

4 Close the file.

Further Study in the User’s Guide

Create Realistic Images and Graphics
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Final Thoughts

Solid modeling is fun and produces impressive, useful images and data. As you practice and 
experiment with solid modeling, you will develop your own preferred techniques. 
Nevertheless, if you focus on the following points, you will be successful and more efficient.

■ Organize your work before you begin. Create a logical set of layers.
■ Use precise and disciplined geometric logic when constructing solids to make sure that 

your models are correct.
■ Always check your work at every step to reduce the likelihood of perpetuating modeling 

errors. View a model from several angles, and use the ID command to verify the 
coordinates of endpoints and the DIST command to verify lengths and distances.

■ Retain reference geometry such as centerlines and profiles. Keep them separate on their 
own layer.

■ Save models at intermediate stages with different file names, so you can easily go back and 
retrieve data.

■ Use just enough detail in a solid model to accomplish your goals.
■ Experiment and have fun!
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